
1

IBM Software Group

September 2005  |  WDSC V6.0 © 2005 IBM Corporation

WebSphere Development Studio Client for 
iSeries: The Remote System Explorer

Advanced



2

IBM Software Group  |  WebSphere software

Remote System Explorer |  Advanced © 2005 IBM Corporation2

RPGWebSphere Development Studio
COBOL

C/C++
PDM
SEU 
SDA,
RLU

Java

Trace

Debug

Profiling DB XML
App

Server

Web

Struts Web
Service

iSeriesiSeries iSeries iSeries
Web

Facing
RSE

iSeries
Projects

Unlimited
Licenses

WebSphere Development Studio Client V6.0

+CODE
+VisualAge RPG

www.ibm.com/software/awdtools/iseries

JSF
EGL
Java 

generation

Current 5722-WDS customers with software subscription
for V5R3 and V5R2, to upgrade use feature #: 2656
Available after GA

HATS
Toolkit

There is now only one application development product sold by IBM, for iSeries, as of V4R5. 
This is WebSphere Development Studio (Development Studio), which includes all four host 
compilers, all traditional tools (ADTS = PDM+SEU+SDA+RLU+DFU+AFP+CGU), and 
unlimited licenses of the workstation-based toolset named WebSphere Development Studio 
Client (formerly WebSphere Development Tools). 

If you are an existing customer who has a subscription, you can upgrade to Development 
Studio free of charge. Without a Software Subscription, there is an upgrade fee. New licenses 
of Development Studio are priced very competitive compared to the combined prices of all 
constituent products. As of V5R1, there is no way to purchase the compilers or tools 
individually. So if you have RPG at V5R1 or higher, you must have Development Studio and 
hence are entitled to Development Studio Client.

For consultants who do not have an iSeries of their own, but still wish to have the client tools, 
Development Studio Client is also made available as a passport advantage product so it can 
be purchased "off the shelf" from IBM Direct. 

Development Studio has been a huge success, with over 80,000 licenses sold. Just as every 
development machine used to have PDM and SEU, every development machine will now have 
all the modern Application Development tools from IBM. This ubiquity is especially important 
for business partners who build and sell software. These Business Partners are now free to 
build software using any of the technologies or tools in Development Studio, and can assume 
their customers will have the tools required to tailor everything from RPG to Java and Web 
user interfaces. This effectively raises the lowest common denominator to a level unparalleled 
by any other operating system. 
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There is now only one application development product sold by IBM, for iSeries, as of V4R5. 
This is WebSphere Development Studio (Development Studio), which includes all four host 
compilers, all traditional tools (ADTS = PDM+SEU+SDA+RLU+DFU+AFP+CGU), and 
unlimited licenses of the workstation-based toolset named WebSphere Development Studio 
Client (formerly WebSphere Development Tools). 

If you are an existing customer who has a subscription, you can upgrade to Development 
Studio free of charge. Without a Software Subscription, there is an upgrade fee. New licenses 
of Development Studio are priced very competitive compared to the combined prices of all 
constituent products. As of V5R1, there is no way to purchase the compilers or tools 
individually. So if you have RPG at V5R1 or higher, you must have Development Studio and 
hence are entitled to Development Studio Client.

For consultants who do not have an iSeries of their own, but still wish to have the client tools, 
Development Studio Client is also made available as a passport advantage product so it can 
be purchased "off the shelf" from IBM Direct. 

Development Studio has been a huge success, with over 80,000 licenses sold. Just as every 
development machine used to have PDM and SEU, every development machine will now have 
all the modern Application Development tools from IBM. This ubiquity is especially important 
for business partners who build and sell software. These Business Partners are now free to 
build software using any of the technologies or tools in Development Studio, and can assume 
their customers will have the tools required to tailor everything from RPG to Java and Web 
user interfaces. This effectively raises the lowest common denominator to a level unparalleled 
by any other operating system. 
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The Remote System Explorer Perspective

This is the familiar default appearance of the Remote System Explorer 
Perspective.
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Customizing the Workbench

The Remote System Explorer Perspective can be customized to look like this.

The editor takes up most of the space, now. It appearance has been changed.

The iSeries Table view resides below the editor and all other views have been 
either closed or moved to the left margin as fast views. 



7

IBM Software Group  |  WebSphere software

Remote System Explorer |  Advanced © 2005 IBM Corporation7

Customizing the Workbench

� Customize Perspective
– View can be 

– moved 
– re-sized
– closed
– hidden as Fast view

– Add other views

� Save Perspective AS…
Replace existing or create new perspective

� Use Window -> Preferences
Workbench, Perspectives

Make Default, Delete

Perspectives can be modified to fit your work style. Move, re-size or close 
existing views. Open other views that you want to add to the perspective. 
Save the customized layout as a new perspective using Window -> Save 
Perspective as.

Settings for your own perspectives as well as the ones shipped with the 
product, can be maintained from Window -> Preferences, expand Workbench 
and select the Perspectives page. 
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Editor Preferences

� LPEX Editor
– Appearance

– Parsers, Parser Settings

� Remote Systems, 
iSeries, LPEX Editor 
Parsers

– Language specific 
settings

There are two places in the preferences that allow editor customization: LPEX 
Editor and Remote Systems, iSeries, LPEX Editor Parsers.

Besides appearance i.e. colour settings, the editor behaviour can also be 
modified.

Examples are syntax checking and column sensitive editing.
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RSE: User Actions

� User-Defined Actions … like PDM!
– Right-click on iSeries Objects -> Work With

– User Actions
– Create, delete or change user-defined actions
– Scope them so you only see them when appropriate

– Named Types
– Create named types to scope actions against
– EG. “RPG” might be RPG + RPGLE + SQLRPGLE

� … and even beyond PDM!
- Create user actions for libs/objects, members … and even jobs 

and IFS folders and files!

While IBM supplies a number of useful actions for remote iSeries objects, it is 
not possible to supply them all. Like PDM, you can easily define your own 
actions.  To create your own actions, use the Work With actions in the popup 
menu for iSeries Objects. These user-defined actions will appear in the popup 
menus for remote resources. To avoid seeing all actions in all popup menus, 
you scope each action to one or more object or member types. You first define 
named collections of object or member types, then you create your actions 
and scope them to one of these named collections of types. You actions will 
then only appear for object or members that match one of the types in the 
collection. These actions can be created for objects, members, jobs and IFS 
folders and files.
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Defining User Actions

Define your own Define your own 
actions for object actions for object 

and member popup and member popup 
menusmenus

PDMPDM--like like substsubst’’nn varsvars

FineFine--grained grained 
scopingscoping

Lots of optionsLots of options

Use Work With -> User Actions to define an object or member action. Object 
actions only appear in the popup menus for libraries or objects. Member 
actions only appear in the popup menus for members. When you define the 
action, you initially specify a label to show in the popup menu and an iSeries 
command to run when that action is selected. This command can use 
substitution variables that are identical to those in PDM. There are also 
numerous options you can specify to affect the action, and you can scope it 
precisely: for example, object actions can be scoped one or more type and 
attribute pairs, and member actions by one or more simple or generic member 
types.
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Substitution Variables

� Many substitution variables
Superset of PDM

� Different sets for objects vs members vs jobs vs IFS
� Use Insert Variable to see list

or Ctrl+Space to see list: or type ‘&’ to get prompted

All PDM substitution variables are supported for the command, and some new 
ones that PDM didn’t support.

When you type &, you see a popup selection list, or you can type Ctrl+Space
or press the Insert Variables button. From the list, double click to insert the 
selected variable, at the cursor position.
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Running User Actions

Once your action is defined, you can use it. Right click on an object matching 
one of the types you specified, and expand the User Actions menu in the pop-
up. Your action appears in the menu. Select it. If you chose to prompt the 
command (via the Prompt option), you will see the GUI prompt for the 
command. When the command has finished running, it results are logged in 
the Commands view. 



14

IBM Software Group  |  WebSphere software

Remote System Explorer |  Advanced © 2005 IBM Corporation14

User Actions for Jobs

� Yes, you can create user actions for Jobs too!

You can also create user actions for Jobs, which will appear in the User 
Actions popup menu for jobs in the iSeries Jobs subsystem under a 
connection. The substitution variables include variables for the selected job’s 
number, user and name.
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User Actions for IFS

� And even IFS folder and files

You can choose You can choose 
between between QShellQShell

commands or QSYS commands or QSYS 
commands!commands!

The substitution variables The substitution variables 
change, depending on change, depending on 

command typecommand type

For For 
QSYS QSYS 
cmdscmds

For For 
QShellQShell
cmdscmds

Similar for Similar for 
Local, Unix, Local, Unix, 

Windows Windows 
and Linux and Linux 

user actionsuser actions

You can also create user actions for IFS folders and files, which appear in the 
User Actions popup menu for folders and files in the IFS Files subsystem 
under a connection. 

You can create user actions that are QShell commands or *CMD objects as 
usual. The substitution variables change depending on the type of command: 
for qsys commands you get the PDM substitution variables, slightly different to 
deal with folder/file names versus object/member names. For qshell
commands, you get a different list using eclipse-style ${…} variables, with 
many variables for all aspects of the selected folder/file name, but a number of 
other environment variables. 

Note the qshell-support is the same as when creating local, unix, windows or 
linux user actions, which are also supported. 
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Running User Actions for IFS

IFS user actions show up in the right click of the IFS files or folders, as shown 
here. If the action is defined to prompt, then you get a prompt dialog where 
you can edit the command before submitting it.
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Work With Compile Commands

� You can change IBM or vendor supplied compile 
commands, and add your own

In additional to user actions, there is specific support for creating compile 
commands too. Use the Work With -> Compile Commands option from the 
iSeries Objects subsystem under an iSeries connection. IBM pre-supplies 
compile commands, and enables vendors to pre-supply commands as well, 
some of which do. 
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Customizing Compile Commands

Subset of PDM Subset of PDM 
substitution substitution 

variables allowedvariables allowed

Brings up Brings up 
larger window larger window 

for editingfor editing

Browse iSeries Browse iSeries 
for *CMD objectfor *CMD object

Create new Create new 
or edit or edit 

existingexisting

Commands Commands 
per member per member 

typetype

Right Right 
click for click for 

more more 
actionsactions

In the Work With Compile Commands dialog, you can create new compile 
commands and edit existing ones. To edit an existing one, first find it by 
selecting the member type it applies to (or add a new member type if 
necessary) at the top of the dialog, and selecting the command in the list of 
commands on the left. Then edit the command and press Apply. You can also 
right-click on a command to delete it, copy/paste it, or re-order it. Note you 
cannot delete IBM-supplied commands, but after editing them, you can restore 
them to their shipped value. 
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Creating New Compile Command

To create a new compile command, select “New command” on the left, and 
then enter the label to show, and command to run, and press Create. The 
command will show up on the list on the left, and will also now be available at 
runtime, as we see on the next slide…
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Running New Compile Command

You will see the You will see the 
Error List view if Error List view if 

the command the command 
generates an generates an 

event fileevent file

Here we see our new compile command appearing when we right click on a 
member of the type we created the command for. Note the checkmark 
appears beside the last-used compile command for the selected member’s 
type. When the compile command runs, if it generates an event file that event 
file is automatically retrieved and the errors produced by the compile are 
displayed in the Error List window, where you can double click to open the 
editor and position it at the error.
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Defining IFS Compile Commands
� Yes, you can even create compile commands for IFS 

files … and even local, Unix, Windows and Linux!
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Running IFS Compile Commands

Here we see our new compile command appearing when we right click on an 
IFS file of the type we created the command for. Note the checkmark appears 
beside the last-used compile command for the selected file’s type. When an 
OS/400 compile command runs, if it generates an event file that event file is 
automatically retrieved and the errors produced by the compile are displayed 
in the Error List window, where you can double click to open the editor and 
position it at the error. When a QShell compile command runs, the errors are 
shown in the Command view, and are double clickable. 
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Preferences For User Actions and Compile Cmds
Window->         

Preferences

&O &O varvar
&R &R varvar
&P &P varvar

&E &E varvar

&H &H varvar
&G &G varvar

&ISJ &ISJ varvar

Specify Specify 
preferences preferences 
here, for all here, for all 
connectionsconnections

Override per Override per 
connection via connection via 

Properties Properties 
dialog for dialog for 

iSeries ObjectsiSeries Objects

There is a preferences dialog that has many preferences which affect 
substitution variables for user actions and compile commands.
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Preferences For User Actions and Compile Cmds

Window->
Preferences

&O &O varvar
&R &R varvar
&P &P varvar

&E &E varvar

&H &H varvar
&G &G varvar

&ISJ &ISJ varvar

Specify Specify 
preferences preferences 
here, for all here, for all 
connectionsconnections

Override per Override per 
connection via connection via 

Properties Properties 
dialog for dialog for 

iSeries ObjectsiSeries Objects

There is a preferences dialog that has many preferences which affect 
substitution variables for user actions and compile commands.
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Running Interactive Commands in RSE

There are three types of iSeries commands in RSE
Normal -> runs in RSE batch job (with adopted user ID)
Batch -> runs via SBMJOB (using preferences for JobD, etc)
Interactive -> runs in interactive job (you must do STRRSESVR)

You will see this prompt in many places. Eg:
When defining User Actions
When defining Compile Commands
When running commands in iSeries Command log view

Within the Remote System Explorer, there are 3 ways to run commands on 
the iSeries: normal, batch or interactive, as described here.  You will see the 
prompt for the three types of commands throughout the RSE, so its important 
to know the differences between them. 
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Running Interactive Commands in RSE

� Step 1: Run STRRSESVR in any emulator

The profileThe profile--qualified qualified 
RSE connection name RSE connection name 

to associate this to associate this 
interactive session interactive session 

withwith

Where to put user Where to put user 
space for historyspace for history

Host name of your PCHost name of your PC

To run interactive commands, you must run the STRRSESVR command from 
within an emulator. Specify the name of the connection within the RSE to 
associate this interactive session with … qualified by profile. It may help to 
select the “Qualify connection names” option in the dropdown of the title bar of 
the Remote Systems view in the RSE, so you can see what profile your 
connection is in. Also specify a library unique to you, to hold *PRV values for 
this command, and of course your PC’s hostname or IP address.
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Running Interactive Commands in RSE
� Step 1: Emulator is now reserved…

When the STRRSESVR command is successful, it will reserve the emulator 
by putting up the screen shown here.
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Running Interactive Commands in RSE
� Step 2: Run interactive command in RSE

Now, within the connection associated with the STRRSESVR command, you 
can run interactive commands from within the RSE, and debug interactive 
programs. The example here shows running STRPDM from the iSeries
command log view. You need to give focus to your reserved emulator to see 
the results…
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Running Interactive Commands in RSE
� Step 2: … and your command runs in emulator:

… and here we see that the reserved emulator is now running the interactive 
command we entered in the RSE.
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Run: from popup menus

Run from Popup 
menu of *PGM
�iSeries appl. in 

RSE job
�Batch 
�Interactive 
�Multi-threaded

Run As 

Run(Prompt) 

You can run programs from the Remote Systems view or the iSeries Table 
view in four ways: 

•In the RSE communications server job

•In a batch job

•In an interactive job 

•In a server job

In the first case, running the program in the same job as the Remote System 
Explorer communications server job,will tie up that job until your program 
ends. With batch and interactive jobs, you cannot monitor the status as easily, 
however, you do not tie up your communications server and you are notified 
when the program ends. Batch jobs work as you would expect, your
application will be submitted to the default batch subsystem. 

Note: A multi-threaded debug session creates a new server job and this way 
keeps the RSE communications server job free for other tasks.
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Run Configurations: for easy re-use!

Existing run configurations are easily Existing run configurations are easily 
accessible in run accessible in run pulldownpulldown!!

Run configurations are for powerful re-use. If what you want to run a program 
that takes a number of parameters, or is not straightforward to launch, you can 
predefine this information into a named configuration. Once created, the 
configuration appears in the configuration list, and can be selected from there. 
Every configuration run also appears in the pulldown menu of the Run tool bar 
button. Clicking the Run tool bar button itself, will run the previous 
configuration again.
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Drilling Down

� Typically we start using the RSE by just expanding:
– Expand Library list to see libraries on lib list

– Expand a library to see all objects in it
– Expand a source file to see members in it

– Expand Home directory to see folders in \home in IFS

– Expand a folder to see all folders and files in it
– And so on

� But sometimes this produces lists that are too big
– Its unwieldy to scroll through thousands of things

– You really want to keep lists small, to a few hundred at 
most

The Remote System Explorer is all about random access to remote things …
like stuff in QSYS, or jobs, or IFS files. While it is designed to be immediately 
useful by merely expanding nodes to drill down to what we want, sometimes 
that can produce unsatisfactory results if this results in vast numbers of items.
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*LIB Expand To � For Quick Filtering

One very quick way to reduce the amount of things is to use the Expand To 
object for libraries. It allows you to expand a library to see only objects of a 
particular type. This subsetting remains in effect forever, even when you re-
expand with the plus sign, until you subsequently choose All or any other 
expand-to criteria. 
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Introducing Filters

� Eventually you will need to see a subsetted list
– Using criteria like generic names, types and attributes

– All subsystems (nodes under a connection) support “filters”

– These allow fine-grained control over what is shown in the RSE.

� To create a filter, right click on any subsystem and 
select New -> xxx

– iSeries Objects -> New -> Library Filter, Object Filter, Member Filter

– iSeries Commands -> New -> Command Set

– iSeries Jobs -> New -> Job Filter

– IFS Files -> New -> Filter

� Or use the fastpath Work With XXX… prompts under 
iSeries Objects

Eventually, you will find the need to see a subsetted list. That is what filters 
offer, and the RSE has extensive filter support. 
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Introducing Filters

PrePre--
defined defined 
filtersfilters

NewNew--
filter filter 

actionsactions

Each of the subsystems contains pre-defined (shipped filters), e.g. Library List 
(*LIBL) and a set of ‘New Filter Actions’, e.g. Work with libraries… Later once 
are filter templates that require user configuration.
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RSE filters for iSeries Objects

� Library filters
– Specify simple, generic or special library names

� Object filters
– Specify simple / generic object names, lib-qualified

– Library name can be simple, generic or special
– Object name can be simple or generic

– Specify simple / generic object types and attributes

– Can specify one or more type:attribute pairs (OR operation)
� Member filters

– Specify simple / generic member names, lib / file-qualified

– Specify simple / generic member types

– Can specify one or more member types (OR operation)

There are three types of filters you can create in the iSeries Objects 
subsystem.

1. Library filters. These list libraries when expanded.

2. Object filters. These list objects when expanded.

3. Member filters. These list members when expanded.

We will see an example of creating each of these. If you are an existing CODE 
user, you can use File->Import to import filters from CODE Project Organizer. 



IBM Software Group  |  WebSphere software

Remote System Explorer |  Advanced © 2005 IBM Corporation39

Library Filters

ExpandExpand Specify simple, special, Specify simple, special, 
or generic library nameor generic library name

Specify a filter nameSpecify a filter name

Here we use the Work With Libraries... prompt to create a library 
filter. Specify the library name, simple or generic, to list when this 
filter is expanded. Note the generic names in RSE support two 
asterisks, not just one as is the case with PDM. On the second page, 
specify the name for this filter.
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Expanding Library Filters

Filter is created, and Filter is created, and 
expanded. It lists all expanded. It lists all 
libraries matching libraries matching 
the given criteria. the given criteria. 

Filter exists until Filter exists until 
you delete ityou delete it

Filter exists in all Filter exists in all 
connections by connections by 

defaultdefault

Use Change Use Change 
to edit filter to edit filter 

laterlater

When a library filter is created, it shows up in the list of existing filters for 
iSeries Objects. You can edit the filter by right clicking on it and selecting the 
Change... action from its popup menu. When a library filter is expanded, all 
libraries matching one or more of the filter's filter strings are listed underneath 
the filter. Note that these libraries can subsequently be expanded, just as they 
can for the Library List filter. 
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Specify object typeSpecify object type

Object Filters

ExpandExpand

Specify simple, Specify simple, 
special, or generic special, or generic 

library namelibrary name

Specify simple or Specify simple or 
generic object namegeneric object name

Specify simple or Specify simple or 
generic object generic object 

attributeattribute

More types More types 
(next page)(next page)

Here you use the Work With Objects... prompt to create an object filter to list 
objects in one or more libraries. Specify the library, the object, the type and 
attribute filtering criteria. All but the object type can be generic.

On the 2nd page of the wizard, you specify the name for this filter. 



42

IBM Software Group  |  WebSphere software

Remote System Explorer |  Advanced © 2005 IBM Corporation42

Filtering objects by type + attribute

Specify multiple Specify multiple 
object type + object type + 
attribute pairsattribute pairs

Prompt for object typePrompt for object type

Prompt for object Prompt for object 
attributeattribute

Will list Will list allall objects with objects with 
anyany of the specified of the specified 

types+attributestypes+attributes

When More When More 
Types>>> pressedTypes>>> pressed

By using More Types>>>, you can specify more than one object type and 
attribute combination. Note the attribute can be generic. This multiple-type 
support is beyond what even PDM supports, and allows for extremely specific 
lists based on filters.
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Expanding Object Filters

Filter is created, and Filter is created, and 
expanded. It lists all expanded. It lists all 

objects matching objects matching 
the given criteria. the given criteria. 

Filter exists until Filter exists until 
you delete ityou delete it

Filter exists in all Filter exists in all 
connections by defaultconnections by default

Use Change Use Change 
to edit filter to edit filter 

laterlater

When an object filter is created, it shows up in the list of existing filters for 
iSeries Objects. You can edit the filter by right clicking on it and selecting the 
Change... action from its popup menu. When an object filter is expanded, all 
objects matching one or more of the filter's filter strings are listed underneath 
the filter. Note that these objects can subsequently be expanded, if they are 
files, just as they can from the Library List filter. 
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Member Filters

ExpandExpand

Specify simple or Specify simple or 
generic member namegeneric member name

More types>> (next page)More types>> (next page)

Specify simple or Specify simple or 
generic file namegeneric file name

Specify simple, Specify simple, 
special, or generic special, or generic 

library namelibrary name

Specify simple or Specify simple or 
generic member typegeneric member type

Here you use the Work With Members... prompt to create an object filter to list 
objects in one or more libraries. Specify the library, the object, the type and 
attribute filtering criteria. All but the object type can be generic.

On the 2nd page of the wizard, you specify the name for this filter. 
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Filtering by member type

Specify multiple member Specify multiple member 
types. Handy when generic types. Handy when generic 

name wonname won’’t workt work

Will list Will list allall member with member with 
anyany of the specified typesof the specified types

When More When More 
Types>>> pressedTypes>>> pressed

By using More Types>>>, you can specify more than one member type. Note 
that each type can be generic. This multiple-type support is beyond what even 
PDM supports, and allows for extremely specific lists based on filters.
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Expanding Member Filters

Filter is created, and Filter is created, and 
expanded. It lists all expanded. It lists all 
members matching members matching 
the given criteria. the given criteria. 

Filter exists until Filter exists until 
you delete ityou delete it

Filter exists in all Filter exists in all 
connections by defaultconnections by default

Use Change Use Change 
to edit filter to edit filter 

laterlater

When a member filter is created, it shows up in the list of existing filters for 
iSeries Objects. You can edit the filter by right clicking on it and selecting the 
Change... action from its popup menu. When a member filter is expanded, all 
members matching one or more of the filter's filter strings are listed 
underneath the filter. 
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Filter Pools

� Eventually you will have too many filters!
– Or you will want a filter not to show in all connections

� Time to turn on “Show Filter Pools”
– Expanding subsystems will then first show filter pools

� Filters are grouped into named pools
– By default they are added to the “default filter pool”

– You can create your own filter pools

– Then add filters to it

– Expand a filter pool to see just the filters in it

– Connections reference filter pools … only see those you reference

– The default pool is always referenced 
� Filter pools group filters

– Nothing more than a named collection of filters

– Allow you to group filters by project, release, connection, task, etc.

There is an advanced feature in the RSE for partitioning filters into named 
collections, called filter pools. To enable this, you must select the "Show Filter 
Pools" preference. It is available from the Remote Systems toolbar down 
arrow menu.

Actually, all filters are contained in a filter pool. By default, they all go into one 
IBM supplied filter pool, named Default Filter Pool. By turning on the Show 
Filter Pools preference, you will see these filter pools when you expand a 
subsystem. When you expand a filter pool, you will then see the filters. Filter 
pools can be used to effectively group filters by task, or project, or release, or 
developer, or whatever you like. 
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Show Filter Pools

ConnectionsConnections
-- SubsystemsSubsystems
-- FiltersFilters

ConnectionsConnections
-- SubsystemsSubsystems
-- Filter PoolsFilter Pools
-- FiltersFilters

Show Filter PoolsShow Filter Pools
changes the view to changes the view to 

show filter pools first, show filter pools first, 
then filtersthen filters

Available from the Available from the 
Remote Systems Remote Systems 
toolbar menutoolbar menu

Here we see how to turn on the Show Filter Pools preference. Once enabled, 
when a subsystem is expanded you see not the filters, but first the filter pools 
referenced by this subsystem in this connection. When a filter pool is 
expanded, then you see the filters within that filter pool. 
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Create a Filter Pool

Now you can create a new Now you can create a new 
filter pool for a connectionfilter pool for a connection……

……and then create filters and then create filters 
in that filter poolin that filter pool

To create a new filter pool, right click on the subsystem, then select New -> 
Filter Pool... 

All you need to specify for your new filter pool is a unique name. This is what 
you see when the subsystem is expanded. Never mind the Profile prompt for 
now, we will explain that later. It is defaulted so you need not think about it. 
When Finish is pressed, the filter pool is created, AND a reference to it is 
added to this subsystem in this connection. No other connection has a 
reference to this new filter pool yet!
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Reference a Filter Pool
By default, only the connection where By default, only the connection where 

you created the filter pool has a you created the filter pool has a 
reference to it, so filters created in it reference to it, so filters created in it 

only appear for that connectiononly appear for that connection

To share a filter pool between To share a filter pool between 
connections, create a reference to connections, create a reference to 

the filter pool from other the filter pool from other 
connectionsconnections

By default, filter pools you create are not shared by multiple connections. To 
affect that, create a reference to the same pool from multiple connections. 
Note any changes made to the filters in the pool are now immediate across all 
shared connections.
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Work With Filter Pools
In In Show Filter PoolsShow Filter Pools mode, there are mode, there are 

two new actions on subsystems two new actions on subsystems 
like iSeries Objects:like iSeries Objects:

1.1. Work With Filter PoolsWork With Filter Pools
2.2. Select Filter PoolsSelect Filter Pools

1. WW Filter Pools:1. WW Filter Pools:
One stop shopping for filter One stop shopping for filter 

pool managementpool management

2. Select Filter Pools:2. Select Filter Pools:
Easily manage which pools this Easily manage which pools this 

connection referencesconnection references

When you are in Show Filter Pools mode, you will see a couple actions on 
subsystems, for managing filter pools and managing references to filter pools. 
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Working disconnected

�� Edit local and offline source files / Edit local and offline source files / mbrsmbrs
�� Syntax check RPG, COBOL, DDSSyntax check RPG, COBOL, DDS

�� Syntax check CL for cached commandsSyntax check CL for cached commands
�� Prompt RPG and DDSPrompt RPG and DDS

�� Prompt CL for cached commandsPrompt CL for cached commands
�� Access language help for RPG, COBOL, DDSAccess language help for RPG, COBOL, DDS
�� Access CL help for cached commandsAccess CL help for cached commands

�� Verify RPG, COBOL, DDS for those members that are cachedVerify RPG, COBOL, DDS for those members that are cached

What you can do while disconnected

�� Edit, design or compile host source membersEdit, design or compile host source members
�� Run or debug host programsRun or debug host programs

�� Run host commandsRun host commands
�� Syntax check, prompt or F1 on CL commands not cachedSyntax check, prompt or F1 on CL commands not cached

�� Verify members not previously verifiedVerify members not previously verified

What you cannot do while disconnected

This summarizes what can and cannot be done when working in disconnected 
mode … that is, without a live connection to an iSeries host.
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Caching
� Verify source member
� Caches information 
� To update cache:

Select Verify (Prompt)

Select Refresh cache

Click OK

When you verify a member, the external references are automatically cached 
locally. On subsequent verifies, the local cache is used. To force a refresh of 
the cache, prompt the verify action and select Refresh Cache. 
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Cache Settings

You can affect cache settings via the Cache preferences page.
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Make Available Offline

In order to work In order to work 
offline, you have offline, you have 
to make a local to make a local 

copy of your copy of your 
member first.member first.

Use Use Make Available Make Available 
OfflineOffline

This creates an iSeries This creates an iSeries 
project, and imports the project, and imports the 
member(smember(s) to it. This is ) to it. This is 
where you work offlinewhere you work offline

What are iSeries What are iSeries 
Projects?Projects?

Stay tunedStay tuned……

To prepare for working offline, use the Make Available Offline action on the 
members you intend to edit. Then, while offline, you edit your source from the 
iSeries Projects perspective. More on iSeries Projects later.
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iSeries Projects 

� A special project type
–For holding source destined 
to be compiled on iSeries

� A dedicated perspective
–For working with all and only 
iSeries projects

There is a special project type designed to hold source that is destined to be 
compiled and run on an iSeries. There is a wizard for creating a new iSeries 
Project. 

There is a special perspective for working with iSeries projects. 
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What is an iSeries project?

� Typical Eclipse project
– Contains folders and files, can be shared by a team

– Can have its own tools and perspectives

� But also
– Holds copies of some source members from an iSeries library

– Those copies are “pushed” up occasionally and the project 
re-built

An iSeries Project is a typical Eclipse project. This means it contains folders 
and files that are in the local file system of the IDE, but these can be 
synchronized with a central repository for team support.

Since the files are local, there is actions to support "pushing" those files up to 
an iSeries library, where they become source members. This is done prior to 
compiling or "building" the source for the purpose of testing.
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iSeries Project Library, files, members

� iSeries Project
– Each iSeries project is associated with a single iSeries library

– 1 to 1 association

– Use File -> New -> iSeries Project wizard to create

� iSeries Source Physical File
– Source physical files represented as folders in the project

– CCSID, record length, IGC data and description stored as “metadata”
for folder

– Use New -> iSeries Source Physical File wizard to create

� iSeries Member
– Members stored as files within “source” folders

– Uses format: memberName.membertype ORDRENT. RPGLE

– Use New -> iSeries Source Member wizard to crate
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iSeries Projects Perspective

Here we see the iSeries Projects perspective, which you can explicitly 
open. The primary view is the iSeries Project Navigator that allows 
exploration of all existing iSeries Projects.  There are wizards
lauchable from the toolbar for creating a new iSeries Project, or 
creating source physical files and source members within an existing 
project. The iSeries Projects perspective includes a full copy of the 
Remote Systems Explorer, as a view, for your convenience. This 
allows you to easily work with the contents of the associated library 
while simultaneously working with the local copies of the source
within the project.
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Give your Give your 
project a project a 

namename

Choose Choose 
connection connection 

from RSE listfrom RSE list

Identify Associated Library: this is the Identify Associated Library: this is the 
target library for pushes and buildstarget library for pushes and builds

iSeries Project wizard

Here we see the iSeries Project wizard. First, give the project a 
name. Any name you want! Then select or create a connection (from 
the RSE!) that identifies the iSeries with which this project is
associated. Also select the library on that iSeries where the contents 
of this project will be pushed to.
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Specify Build Style andSpecify Build Style and
style configuration parametersstyle configuration parameters

for iSeries Projectfor iSeries Project
more information on next slidemore information on next slide ......

Build style controls how the iSeriesBuild style controls how the iSeries
project is built on the remote systemproject is built on the remote system

iSeries Project Wizard (next page)

Here we see the rest of the iSeries Project wizard. Here you specify 
what to do for the Build action on a project. There are 3 IBM-supplied 
choices, and ISVs can add more choices. The default is to generate a 
CL source member containing a compile command for each member 
that is changed.
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Build Styles

� Specify how to build the iSeries project on the 
remote system

� Three IBM supplied build styles

CL program

Command

*NONE

� ISVs can plug-in additional build styles

CL program

• Automatically generates COMPILE.CLLE and BIND. CLLE

• Adds compile command for each source file in project

• Uses last compile command from RSE for specified source type

• For example, CRTBNDRPG versus CRTRPGMOD

• At build time these two members are pushed to iSeries, compiled 
and run

Command

• You specify single command to run build

• Good if you have an existing build script

ISVs can plug-in additional build styles to work with their existing iSeries 
systems
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Specify attributes that are Specify attributes that are 
used when file is finally used when file is finally 

created in associated librarycreated in associated library

Select Select 
ProjectProject

Source File = a folder in your projectSource File = a folder in your project
ƒƒUntil you "Push" your changes. Until you "Push" your changes. 
ƒƒThen a CRTSRCPF is doneThen a CRTSRCPF is done

iSeries Source Physical File Wizard

Here we see the wizard for creating a new iSeries source physical 
file. Within the project, this is actually a folder. When the project is 
pushed to its associated library, this result in a CRTSRCPF command 
being run to create a file with the attributes specified in this wizard.
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Select the Select the 
parent folder parent folder 

(src file)(src file)

Member = a file in your Member = a file in your 
folderfolder
ƒƒUntil you "Push" your Until you "Push" your 

changes. changes. 
ƒƒThen an ADDPFM is Then an ADDPFM is 

done, ordone, or
ƒƒContents of remote Contents of remote 

member are replacedmember are replaced
Enter the Enter the 

member name member name 
and select and select 

source typesource type

iSeries Member wizard

Here we see the wizard for creating a new iSeries source member 
within an iSeries project. Actually, it is within a source phyical file (aka 
folder) within an iSeries project. Locally, a member is really a file on 
disk. The file's extension is the member's type, as in ABC.RPGLE.  
When this project is pushed to its associated library, this will result in 
an ADDPFM command being run to create the file with the name and
type, in its parent file.
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What about existing members?

� Use Import or Add to Project action to copy them

� Files added become folders locally

� Members added are copied to that folder

� Developer works on local copy

� Full power of Eclipse at disposal

Add project action

•Right click on project, select “Show Remote Objects”

•Drill down to source file, right-click, select “Add to Project”

•Drill down to members, right-click, select “Add to Project”

Developer works on local copy

•Edits file

•Pushes changes using “Push” action

•Does a build using “Build” action

•Shares with team using “Synchronize” action
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Currently showingCurrently showing
only local only local 
resourcesresources

Project “Show Remote Objects” mode

Here we see an iSeries project in the iSeries Navigator, within the 
iSeries Projects perspective, that has a number of local files and 
members. Right-clicking on the project or anything in the project, 
gives a popup menu with the all-important "Show Remote Objects" 
menu item.... 
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(Remote) => (Remote) => 

ƒƒonly exists in associated libraryonly exists in associated library
(Local/Remote) =>(Local/Remote) =>

ƒƒexists locally and in associated libexists locally and in associated lib
(Local/Remote) =>(Local/Remote) =>

ƒƒconflict between local and remoteconflict between local and remote
otherwise =>otherwise =>

ƒƒonly exists locallyonly exists locally

Project “Show Remote Objects” mode Now showingNow showing
both local and  both local and  

resourcesresources

To add a remote member to the To add a remote member to the 
project, select project, select Add To ProjectAdd To Project

To do actions against remote objects, use To do actions against remote objects, use 
Show In Remote Systems ViewShow In Remote Systems View

Once "Show Remote Objects" is enabled (it is a toggle) all the objects 
in the associated library for this project are shown in the iSeries 
Project Navigator. This navigator is called a "bleed through" view 
because it lists both local files/members and remote objects, files and 
members. However, if a file or member exists both locally and 
remotely, it is not shown twice. Rather, it is only shown once, and its 
icon and bracketed text identify it as existing in both places. The icons 
and text enable you to see at a glance which files/members exist only 
locally, only remotely, or both locally and remotely. In the latter case, 
the color of the icon indicates if the two are in synch or not. If not, it is 
an indication you need to "push" your local source to the associated 
library to get it in synch. 
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Project Build

After editing, you After editing, you 
can push and can push and 

build your build your 
changeschanges

After editing, you will want to send the changed members back to the 
associated library, and then compile them there. This can be done in one step 
with Submit Build, or in two steps with Push Selected and then Generate 
COMPILE.CLLE.
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Refresh interval Refresh interval 
determines how frequently  determines how frequently  

status is updatedstatus is updated

Status of the Status of the 
buildbuild

Retrieve errors from Retrieve errors from 
build to the build to the 

iSeries Error ListiSeries Error List

Job where buildJob where build
is runningis running

iSeries Build Job Status

This shows the Build Job Status view where you can monitor your 
submitted build jobs.
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Generated CL Member for Build

An example of what is generated for the build. This is a CL member. You can 
affect what compile command is used for each member type.



IBM Software Group  |  WebSphere software

Remote System Explorer |  Advanced © 2005 IBM Corporation73

Team 
Repository

Dev1 Lib Dev2 Lib Dev3 Lib

Prod Lib

Test Lib

library list library list library list

Dev1 IDE Dev2 IDE Dev3 IDE

push
build

push
build

push
build

team 
sync

team 
sync

team 
sync

Using Projects

The typical usage scenario for iSeries projects is to use them for 
tasks, such as adding a feature to an existing application. Rarely will 
you use an iSeries project to hold all the source for an application... 
use an iSeries change management vendor for that.  Consider a 
change that involves 3 developers changing a number of files...

The lead developer will create the iSeries project and synchronize it 
with the repository. The other developers will use the Eclipse team 
support to add that project to their workspace. Each will change the 
properties of the project to associate it with their own private library. 
The master library containing all the source will be on their library list, 
so compiles will work, but their private library will only hold the 
members they work on. If they use an SCM product, then they will
use it to check source members out to their private library. These 
members and files will then be imported into their project, where they 
will edit them.

After editing, they will "push" their changes to their library and do a 
"Build" or a compile, and run and test their unique changes.

Every so often, they will do a team synchronization to give their 
changes to their fellow team members, and pick up the changes of
those team members. After a synch, they will push their colleaque's 
files to their own associated library and test the changes all work 
together.

At the end of the cycle, someone will pick one of the libraries, and use 
the SCM product to promote their changes back into the test and 
production stages.



IBM Software Group  |  WebSphere software

Remote System Explorer |  Advanced © 2005 IBM Corporation74

Profiles

� The RSE is designed for team sharing
– Of connections

– Of filter pools

– Of user-defined actions

– Of compile commands

� Team sharing is enabled by profiles
– All connections, filter pools, user actions are scoped per profile

– Each profile is a folder within the RSE project
– All data stored within subfolders

– When RSE project is team-synched

– All out-going changes sent to team repository
– All in-coming changes received from team repository

We see that with the RSE you will be creating connections, filter 
pools, user defined actions and compile commands. In a team 
environment, we might wish to share some or all of this information to 
save the effort of each team member having to redundantly create
them. This is especially for team members working on a shared task, 
such as mainenance of an application. The RSE leverages the 
Eclipse team support to enable this.

The first order of business for effectively enable team support is to 
allow delineation between "team" information and "private" 
information per developer.  The RSE enables this by using profiles. 
Every bit of information you create in the RSE is owned by a specific 
profile, and each developer decides which profiles they wish to see 
the information of. Team sharing is done using the Eclipse team 
support, which uses a central repository, and a "synchronize" action 
to synchronize individual developer's information with the repository.  
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RSE Enhancements in version 6.0

�CL Changes
Indicator for used parameters
Selective prompting: 

Support of all prompt modifiers (ie ?*)
Support labels and comments (when editing CL source). 
Additional error checking for built-in commands (ie

%SST)
A refresh cache button
Context of non-edit and edit mode will be permitted

�Error List enhancements
�No power user/admin authority on windows to 

access PV and SC

We see that with the RSE you will be creating connections, filter 
pools, user defined actions and compile commands. In a team 
environment, we might wish to share some or all of this information to 
save the effort of each team member having to redundantly create
them. This is especially for team members working on a shared task, 
such as mainenance of an application. The RSE leverages the 
Eclipse team support to enable this.

The first order of business for effectively enable team support is to 
allow delineation between "team" information and "private" 
information per developer.  The RSE enables this by using profiles. 
Every bit of information you create in the RSE is owned by a specific 
profile, and each developer decides which profiles they wish to see 
the information of. Team sharing is done using the Eclipse team 
support, which uses a central repository, and a "synchronize" action 
to synchronize individual developer's information with the repository.  
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Indicator for specified parameters

We see that with the RSE you will be creating connections, filter 
pools, user defined actions and compile commands. In a team 
environment, we might wish to share some or all of this information to 
save the effort of each team member having to redundantly create
them. This is especially for team members working on a shared task, 
such as mainenance of an application. The RSE leverages the 
Eclipse team support to enable this.

The first order of business for effectively enable team support is to 
allow delineation between "team" information and "private" 
information per developer.  The RSE enables this by using profiles. 
Every bit of information you create in the RSE is owned by a specific 
profile, and each developer decides which profiles they wish to see 
the information of. Team sharing is done using the Eclipse team 
support, which uses a central repository, and a "synchronize" action 
to synchronize individual developer's information with the repository.  
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Selective prompting

We see that with the RSE you will be creating connections, filter 
pools, user defined actions and compile commands. In a team 
environment, we might wish to share some or all of this information to 
save the effort of each team member having to redundantly create
them. This is especially for team members working on a shared task, 
such as mainenance of an application. The RSE leverages the 
Eclipse team support to enable this.

The first order of business for effectively enable team support is to 
allow delineation between "team" information and "private" 
information per developer.  The RSE enables this by using profiles. 
Every bit of information you create in the RSE is owned by a specific 
profile, and each developer decides which profiles they wish to see 
the information of. Team sharing is done using the Eclipse team 
support, which uses a central repository, and a "synchronize" action 
to synchronize individual developer's information with the repository.  
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Support Labels and Comments

NEW!

We see that with the RSE you will be creating connections, filter 
pools, user defined actions and compile commands. In a team 
environment, we might wish to share some or all of this information to 
save the effort of each team member having to redundantly create
them. This is especially for team members working on a shared task, 
such as mainenance of an application. The RSE leverages the 
Eclipse team support to enable this.

The first order of business for effectively enable team support is to 
allow delineation between "team" information and "private" 
information per developer.  The RSE enables this by using profiles. 
Every bit of information you create in the RSE is owned by a specific 
profile, and each developer decides which profiles they wish to see 
the information of. Team sharing is done using the Eclipse team 
support, which uses a central repository, and a "synchronize" action 
to synchronize individual developer's information with the repository.  
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Error Checking for CL built-ins functions

We see that with the RSE you will be creating connections, filter 
pools, user defined actions and compile commands. In a team 
environment, we might wish to share some or all of this information to 
save the effort of each team member having to redundantly create
them. This is especially for team members working on a shared task, 
such as mainenance of an application. The RSE leverages the 
Eclipse team support to enable this.

The first order of business for effectively enable team support is to 
allow delineation between "team" information and "private" 
information per developer.  The RSE enables this by using profiles. 
Every bit of information you create in the RSE is owned by a specific 
profile, and each developer decides which profiles they wish to see 
the information of. Team sharing is done using the Eclipse team 
support, which uses a central repository, and a "synchronize" action 
to synchronize individual developer's information with the repository.  
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Additional Information

�homepage:  
http://ibm.com/software/awdtools/iseries

Select Library link for Labs, Tutorials, Presentations

�newsgroup: 
news://news.software.ibm.com/ibm.software.websphere.code400

�email distribution list:
“This is the Websphere Development Studio Client for iSeries  (WDSCI-L) 

mailing list
To post a message email: WDSCI-L@midrange.com
To subscribe, unsubscribe, or change list options,

visit: http://lists.midrange.com/mailman/listinfo/wdsci-l
or email: WDSCI-L-request@midrange.com

Before posting, please take a moment to review the archives
at http://archive.midrange.com/wdsci-l.”

We hope this presentation helped you understand more about Development 
Studio Client iSeries application development tools.  We started with an 
overview of our strategy for iSeries application development tools, went onto 
review the Remote System Explorer, the perspective for iSeries programmers 
to maintain and develop iSeries applications and explained how to extend 
RSE to include your own iSeries application development tools. 
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Legal information

Acknowledgement:
� This presentation is a collaborative effort of the IBM Toronto iSeries 

Application Development presentation team, including work done by:
Phil Coulthard, George Farr, Inge Weiss, Claus Weiss, and Don 

Yantzi
Disclaimer:
� The information contained in this document has not been submitted 

to any formal IBM test and is distributed on an as is basis without 
any warranty either express or implied.  The use of this information 
or the implementation of any of these techniques is a customer 
responsibility and depends on the customers' ability to evaluate and 
integrate them into the customers' operational environment. While 
each item may have been reviewed by IBM for accuracy in a specific 
situation, there is no guarantee that the same or similar results will 
result elsewhere. Customers attempting to adapt these techniques
to their own environment do so at their own risk.

Reproduction:
� The base presentation is the property of IBM Corporation.  

Permission must be obtained PRIOR to making copies of this 
material for any reason.
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References in this document to IBM products or services do not imply that IBM intends to make them available in every country.

The following terms are trademarks of International Business Machines Corporation in the United States, other countries, or both:
Instruction:  Refer to the following URL:  http://www.ibm.com./legal/copytrade.shtml.  Edit the list below, IBM subsidiary statement, 
and special attribution companies which follow so they coincide with your presentation.

Rational is a trademark of International Business Machines Corporation and Rational Software Corporation in the United States, other countries, or both.
Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.
Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both. 
Intel, Intel Inside (logos), MMX and Pentium are trademarks of Intel Corporation in the United States, other countries, or both.
UNIX is a registered trademark of The Open Group in the United States and other countries.
SET and the SET Logo are trademarks owned by SET Secure Electronic Transaction LLC. 
Other company, product or service names may be trademarks or service marks of others. 

Information is provided "AS IS" without warranty of any kind.

All customer examples described are presented as illustrations of how those customers have used IBM products and the results they may have achieved.  Actual environmental costs and performance characteristics 
may vary by customer.

Information concerning non-IBM products was obtained from a supplier of these products, published announcement material, or other publicly available sources and does not constitute an endorsement of such 
products by IBM.  Sources for non-IBM list prices and performance numbers are taken from publicly available information, including vendor announcements and vendor worldwide homepages.  IBM has not 
tested these products and cannot confirm the accuracy of performance, capability, or any other claims related to non-IBM products.  Questions on the capability of non-IBM products should be addressed to the 
supplier of those products.

All statements regarding IBM future direction and intent are subject to change or withdrawal without notice, and represent goals and objectives only.  Contact your local IBM office or IBM authorized reseller for the full 
text of the specific Statement of Direction.

Some information addresses anticipated future capabilities.  Such information is not intended as a definitive statement of a commitment to specific levels of performance, function or delivery schedules with respect to 
any future products.  Such commitments are only made in IBM product announcements.  The information is presented here to communicate IBM's current investment and development activities as a good faith 
effort to help with our customers' future planning. 

Performance is based on measurements and projections using standard IBM benchmarks in a controlled environment.  The actual throughput or performance that any user will experience will vary depending upon 
considerations such as the amount of multiprogramming in the user's job stream, the I/O configuration, the storage configuration, and the workload processed.  Therefore, 

no assurance can be given that an individual user will achieve throughput or performance improvements equivalent to the ratios stated here.

Photographs shown are of engineering prototypes.  Changes may be incorporated in production models.
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